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OnColor QC – Quick Start Instructions 
A complete OnColor User’s manual is included on your installation CD.  It was 
copied to your hard drive during installation of the software and a shortcut to 
open it was placed on your Windows desktop.  Look for the MS Word document 
called “OnColor Manual v6x.doc”.  A shortcut to this Quick Start Guide was also 
placed on your Windows desktop. 
 

OnColor QC Overview and Quick Start: 
 

1. Follow the instructions in the installation brochure to install the OnColor 
software that came with your software package.  AFTER you install the 
software attach the Hardlock key to the USB port on your computer.  Start 
the OnColor software by double-clicking on the icon on your desktop that 
looks like this: 

 
2. You will see a splash screen of the OnColor logo followed by the default User Screen.  

The default User Screen will look similar to this for spectrophotometers: 
 

 
3. For colorimeters such as the CR-400 or CR-300 series, the default screen only shows 

two of these quadrants. 

4. Before you can begin taking measurements with your color instrument, you must connect 
the instrument to a serial or USB port on the computer and establish communications.  
See the section below on “Establishing Communications with your Color Instrument”. 

5. Calibrate your instrument according to the section below entitled “Instrument Calibration”.  
Your instrument manual will give you detailed instructions on how and when to perform 
correct calibration.  To start the calibration procedure in OnColor, simply type 
“C” or click on the Calibrate icon on the tool bar.  If you need to change the set-
up of the instrument, go to Options  Instrument Settings.  See the section 
below for more detail. 
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6. You are now ready to begin taking measurements.  You must always start by declaring a 
Standard (either by measuring, recalling, or keyboard entering it).  To measure a 
Standard, type “S” on the keyboard or click on the Measure Standard icon on 
the tool bar.  Enter a name for this color and then position the sample at the 
measuring port of the instrument.  Press “Enter” or click on the OK button to 
initiate the reading. 

7. You will see the addition of the measurement data to the User Screen. 

8. To compare another sample to this Standard, you will designate it as a Trial.  To 
measure a Trial, type “T” on the keyboard or click on the Measure Trial icon on 
the tool bar.  Enter a name for this sample and then position it at the measuring 
port of the instrument.  Press “Enter” or click on the OK button to initiate the 
reading. 

9. You will see the addition of the measurement data to the User Screen and will note that 
the data for the Trial is compared to the Standard and color difference is calculated. 

10. You can continue measuring other samples as Trials against this 
Standard.  OnColor will handle an unlimited number of trials compared to 
one Standard.  Use the  and  arrow keys on the keyboard or the 
toolbar to scroll through the different Trials. 

11. You can save this data to a file by clicking on File  Save.  The data is then saved to a 
save-set file (WSV format).  See the section below on Save-Set files for more description. 

12. To enter a new Standard, click on File  New to open a new document.  Follow steps 6 – 
11 above to measure a new set of samples.  OnColor works with multiple documents or 
pages of data open at a time. 

About Report Properties 
 
Depending on the level of OnColor license that you have obtained, up to six different QC report 
screens are available to display your color data.  You can 
change from one report to another by clicking on any of the 
following icons on the tool bar.  These are called report 
screens. 
 
The look and layout of each Report screen can be changed or customized to your preferences.  
The design of each screen is saved into a template called a Report Property.  This template or 
.PRP file does not change or affect your data.  It only changes how and where it is displayed on 
the various Report screens.  The Save-set or WSV file contains the actual data. 
 
You can create and store as many templates or PRP files as you can imagine, but the most 
important one is the one called STARTUP.PRP.  This template is the one that is applied every 
time OnColor is started.  It is the default property file.  You can make changes to the lay-out or 
template and save them by going to Report  Save Properties As and then saving your new 
design as STARTUP.PRP.  Or, you can give it a different name and apply this template by 
clicking on Report  Recall Properties and then selecting the name of the PRP file that you gave 
it. 
 
One item that you will want to change immediately in all Property files is your company name and 
address.  This is changed by clicking on File  Page Setup.  Enter the new information for your 
company name, address, and comment and then make the change permanent by saving your 
STARTUP.PRP file again.  You can also add your company logo for the print-outs by checking 
the box.  You will also need a JPG, BMP, or GIF file of the logo.  You must point to its location 
using the option View—Logo File where you browse and point to the location of the file on your 
computer. 
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As a general rule, you can change any item or “setting” on the report screen by double-clicking 
directly on the object that you want to change.  For example, to change the Color Space or 
Illuminant or Observer, double click on the item that you want to change.  This will bring up a 
Properties dialog box where you can make your new selection.  To change the lay-out of the 
screen, double-click on a blank area of the screen and the appropriate dialog box will appear 
where you can change the lay-out of that report screen.  This applies not only to the User Screen, 
but also to all other Report Screens.  Double-clicking on the name of the Standard or Trial will 
bring up an Edit dialog where you can change the name or other data associated with this 
measurement. 

On the tool bar, you can also click on this icon to change the Report Properties:   
On the User screen, you can resize the quadrants by hovering the mouse on the quadrant 
splitters and click and drag the lines to the new position.  If you hover over the intersection of the 
splitters, the cursor will change to a + sign and you can click and drag both directions at once. 
 

OnColor Navigation Aids 
 
Once you have calibrated your instrument and measured a few samples into a Save-Set, it’s easy 
to navigate through OnColor.  Several Navigation Aids are available to streamline the use of 
OnColor. 
 
1. Use the  and  arrow keys on the keyboard or on the toolbar to scroll through 

the different Trials. 
2. Right click on any screen to bring up a shortcut menu for the most common 

options.  On the QC Report screens, this includes these options at the left: 
3. On the Color Plot or Spectral Plot report screens you can use the Zoom 

features to zoom in or out on any portion of the graph. 
4. Display the name of any Standard or Trial by gliding the mouse over that point. 
5. Double click on any data point to bring up the Edit dialog box where you can 

change it. 
6. Double click on any graph to bring up the change Properties dialog box where 

you can configure the type of data that you want to display. 
7. All of these options are also available via the Menu options. 
8. Use the Keyboard Shortcuts described below to get single keystroke access to the most 

commonly used commands. 
9. Remember that if you make any changes to the screen design and you want to make those 

changes permanent, then you need to save the Property file (under Report-->Save Properties 
As).  You can save it as STARTUP.PRP as the default or give it another name. 

 
 

Keyboard Shortcuts: 
 
OnColor allows the user to create and modify 
existing keyboard short cuts.   These short cuts 
can be modified or viewed by selecting 
View Keyboard Shortcuts.  Select a Menu 
category (such as File, Standard, Trial, etc)  from 
the drop down list and then under the Commands 
window, click on the option that you want to 
create the shortcut to.  In the Press New Shortcut 
Key box, type the keystroke that you want to 
assign.  It is not case sensitive and function keys 
are allowed along with the use of CTRL and ALT.                
Click on Assign button and your shortcut is 
created.  You can assign additional shortcuts at 
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this point. 
 
OnColor comes pre-configured with a few basic shortcut keys.  You can add to these or modify 
them to suit your application: 
 
C = Calibrate S = Standard Measure   T= Trial Measure 
D = Database of Standards F1 – Help    F2 = Standard Save 
F3 = Trial Save F4 = Standard Recall   F5 = Trial Recall 
F6 = Search 
 
You can set-up your own short-cut keys to further customize OnColor for your application and to 
streamline your procedures. 
 

Establishing Communications with your 
Color Instrument  

1. Make sure your Spectrophotometer or Chroma 
Meter is turned on and attached to the serial port 
or a USB port and then launch the OnColor 
program. 

2. Go to Options and select Communications.  The 
following text box will appear.  

3. Select your Instrument type from the Instrument 
list.  

4. Identifying which Port the instrument is 
connected to is critical.  If using a serial to USB 
adapter, please pay attention when the USB 
driver is installed and note what port was 
assigned to it.  You will need this information 
here.  You can also look in the Windows Control 
Panel Device Manager to find this information. 

5. Click on Test settings. 
6. A text box will appear telling you if you have successfully communicated with your 

instrument. 
 
 
 
Hints and Reminders: 
1. OnColor recognizes Com1-99.  Make sure you know what Com port your instrument is 

assigned to. 
2. Some instruments store the white calibration data in the memory of the instrument while 

others use an external file to store it.  If your instrument requires some external files, you will 
need to copy those files to an appropriate directory for OnColor to find them. 

3. If you can’t establish communication and you feel that all the parameters are correct try 
toggling the power on the Spectrophotometer and hit test settings again. 

4. An in depth discussion and troubleshooting guide for establishing Communication can be 
found in OnColor help.  This topic is found by selecting the help drop down menu, index, and 
finally select the topic “establishing communication with a spectrophotometer.” 

5. Demo mode is the default mode when no instrument is connected to the software.  Always 
insure that the proper instrument communication is established.  The instrument type 
currently active is displayed in the bottom right corner of the OnColor program as shown in 
the highlighted area below.   
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Instrument Calibration:  
 
Quick Steps: 
1. Type the letter “C” or click on the Calibrate icon on the toolbar and the software will ask you 

to perform a zero or black calibration. 
2. If your instrument is equipped with a black trap position the trap over the instrument port and 

hit ok. 
3. The software will then ask you to perform a white calibration.  Position your white tile over the 

instrument port and hit ok. 
4. The software will give a successful calibration message. 
 
Hints and Reminders: 
1. The instrument settings allow a user to change the area of view, Specular component, and # 

of flashes per measurement.  Go to Options-->Instrument Settings to change the setup of the 
instrument.  The current settings are always shown in the Status bar in the highlighted area 
shown below: 

 
 
2. For a detailed description of the Instrument settings options look under the help Index and 

selecting the following string of topics: Help, Index, Options menu, Calibration, and 
Instrument Calibration and setup dialog.  

Instrument Settings: 
 
Quick Steps: 

1. Go to Options  Instrument Settings. 
2. A dialog box similar to the one at the right will allow you to change the set-up conditions 

for your instrument.  Not all options are available for all instruments. 
3. Select the conditions for measurement and then click OK or click on Calibrate to proceed 

with the calibration procedure. 
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Hints and Reminders: 
 
1.  An Instrument status code appears in the lower right corner of the screen.  It is composed of 
three boxes; in the left and right boxes you will find a 6-letter code. The code in the left box refers 
to the instrument conditions under which the current standard was measured.  The code in the 
right box refers to the current conditions of the instrument. In the center box the instrument model 
appears.  If the instrument is set to Demo Mode, then the computer is NOT communicating with 
an instrument and you need to go to Options  Communications to establish communications 
with your instrument.  
 

Instrument Status Codes 
 

Position Letter Meaning 
 

1 B 
C 
H 
K 
L 
X 

100% Line Calibration 
Ceramic Calibration 
Hitch Calibration 
Keyboard Input 
Low Illumination Calibration 
Not Calibrated 

2 R 
T 
P 

% Reflectance 
% Transmission 
Profiled %R 

3 I 
E 
B 

Specular Component Included (Gloss Included or SCI) 
Specular Component Excluded (Gloss Excluded or SCE) 
Both SCI and SCE 

4 A 
E 
F 
G 
I 
P 
Q 
R 

Extra Filter 
UV Component Excluded  
UV Component Excluded w/420nm Cutoff 
UV Component Excluded w/400nm Cutoff 
UV Component Included 
Partial UV 
Partial UV w/420nm Cutoff 
Partial UV w/400nm Cutoff 

5 X 
L 
M 
S 
V 
U 

Extra Large Lens 
Large Aperture lens setting (LAV) 
Medium Aperture lens setting (MAV) 
Small Aperture lens setting (SAV) 
Very Small Aperture lens setting (VSAV) 
Ultra Small Lens 
 

6 X 
L 
M 
S 
V 
P 
U 

Extra Large Mask (XAV) 
Large Area of View mask (LAV) 
Medium Area of View mask (MAV) 
Small Area of View mask (SAV) 
Very Small Area of View mask (VSAV) 
Petri Dish Accessory (CM-3500d only) 
Ultra Small Lens 

 
Hints and Reminders: 
 
1. When recalling a standard, always check the instrument status box to the left of your 

instrument type; this displays the instrument status originally used to measure the standard. 
2. Always compare a standard to a trial with the same instrument status. 
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Tool bar icon descriptions: 
 
The toolbar is displayed across the top of the application window, below the menu bar.  The 
toolbar provides quick mouse access to many tools used in OnColor and Colorant Analysis.   
 

 
Icon descriptions: (listed left to right) 
 
1. Open a new data file. 
2. Open an existing data file. 
3. Save the active data file. 
4. Opens print dialog box. 
5. Print preview the active data file. 
6. Context sensitive help. 
7. Show the next trial. 
8. Show the previous trial. 
9. Calibrate. 
10. Measure  Standard. 
11. Measure Trial. 
12. Show the notes for the current standard. 
13. User Report screen.* 
14. Color Plot Report. 
15. Data Table Report * 
16. Spectral Plot Report & 
17. Tolerance Plot Report * 
18. Statistics Report * 
19. Change the report properties. 
 
*  These features are not available with the Lite version of OnColorQC. 
& These features are not available with the Colorimeter version of OnColorQC. 
 
Hints and Reminders: 
1. Drag the mouse on top of an icon and a label will be displayed with a brief description of the 

icon. 
2. Further descriptions of the toolbar options can be displayed in help.  Select the index option 

and type in the word toolbar and display the help file regarding the toolbar. 
 

Report Screens: 
 
OnColorQC offers the user six different “Report Screens” or  views selectable from the toolbar.  
These reports offer a wide variety of display options and can be customized by selecting the 
property icon and  defining conditions in the dialog box that is displayed.  The six screen views 
are: 

 
1. User Screen:   The user-defined report screen is the default screen that 

appears when the program is accessed.  It divides the screen into four 
quadrants, and each of the quadrants can be customized using the properties 
icon.  This is the most commonly used report and in most cases, can be 

customized to show all the required data. 
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2. Color Plot:  This screen displays a plot of the active save-set in a color 

space along with the colorimetric data, deltas, indices, color assessments and 
Pass/Fail.  Either 2D or new 3D graphical plots can be selected for one or 
three illuminants.  The user has the option to change color space equations, 
scale, trial markers, etc. 

 
 
3. Data Table:  This screen displays a spreadsheet-like table of the 

colorimetric and color difference data.  Color patches, assessments, indices, 
and job tags can be included. With one-click, the displayed data can be 
exported to a spreadsheet. 

 
 
4. Spectral Plot:   This screen view displays the active datafile’s standard and 

trial reflectance data.  As with all the screen views the user can manipulate the 
screen by selecting the properties button on the toolbar. 

 
 

5. Tolerance plot:  This screen view displays a graphical representation of the 
numerical values which define a range of color variation between samples 
which is considered acceptable. 

 
 
6. Statistics plot:  This screen shows a trend chart of the active datafile with 

multiple graphs displaying colormetric values such; delta L, delta A, and delta 
B and delta E.  The mean, standard deviation, and variance are displayed for 
this population of selected trials. 

 
 
Hints and Reminders: 
1. All of the screen views are selectable from the toolbar or the Report menu. 
2. The user can customize the active screen view by selecting the property button on the tool 

bar or double-clicking on the report.  A right click will bring up a shortcut menu of the most 
commonly used options for that screen. 

3. A detailed description of the customizable options available for each screen view can be 
found in the help index. 

 

OnColor Help: 
 
OnColor contains a online help file that is extremely extensive and covers a wide range of topics 
and information.  The help  file can also be found as a word document in the 
\OnColor\Documentation folder on your hard drive or on the OnColor CD.  The online help can be 
accessed from the help drop menu.   Additional documentation is also found in the 
\OnColor\Documentation folder.  A full OnColor manual can be accessed by clicking on the 
shortcut to the manual that was placed on your Windows desktop at installation. 
 
 
Hints and Reminders: 
1. For directions on using the help select the option using help found under the help drop menu. 
2. OnColor help offers detailed step by step outlines of almost every function in the OnColor 

program. 
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Using the OnColor Database of Standards 
 
A very powerful feature of OnColor is the Database of Standards.  This option is used to store 
reflectance data and tolerances for standards, associated trials, and formulas.   You will have the 
ability to: Search for closest match, Recall Standard, with or without the associated Trials, as well 
as to “filter” your searches or recalls for a particular “customer” or “color palette”.  The Database 
of Standards is stored as a Microsoft 
Access MDB file.  This file type is ODBC 
compatible and can be read using MS 
Access.  This file structure is very useful for 
networked applications and for viewing 
data in real time.  Alternately, an SQL 
database can be used.  An empty database 
named “Color Database” is installed with 
OnColor V6 and is the default Database of 
Standards upon startup.  You can begin 
using this database “as is”, or you can 
rename it.  The default setup for the 
Database of Standards does not use the 
ODBC Data Sources.  You can use this 
option if you wish by checking the box for it 
in the Transfer tab.  If you want to connect 
to an existing V5 database, you will need to 
use the ODBC setup.  OnColor is also 
shipped with an empty database of 
standards.   It is installed to the default 
directory chosen at the time of installation.  
Go to View-->Default Directories to see what this is.  You can make a copy of this empty 
database and rename it according to your needs. 
 
There are five tabs under the Database of Standards Options: 

• Transfer 
• Search 
• Filter 
• Edit/Delete 
• Formulas (shown only with Match Gold and Silver licenses) 

 
Transfer Tab is used to Change the Database, create a new one, or manage an existing one.  It 
can be used to move records back and forth between the current open documents and the 
database.   
 
Search Tab is used to specify the parameters for the Search for Closest Match feature in the 
database.  Under Trial Returned, you can select the number of closest matches to be returned as 
Trials.  The Trials are appended to the current document in order from smallest to largest DE.  
You can also select the Maximum Delta E for the Trials.  The Closest Match will always be 
returned even if it exceeds this Delta E value.   
 
Filter Tab is used to activate/deactivate database filtering on the Search and Recall features of 
the database.  To activate Database Filtering, click in the box to check it or turn it on; uncheck the 
box to deactivate or not use any filtering options. 
 
If database filtering is turned on, then only those records that match the specified criteria will be 
listed on a Search or Recall function.  In the example shown, only samples that are for the 
Customer and the Palette shown will be listed.  You can use one or more of the filters at a time.  
The Alternate Name field is a free form field; the Customer and Palette fields must be selected 
from the drop down list; and the Date/Time is specified in the format shown. 
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The Customer and Palette fields are originally created in the List Management section under the 
File menu where you can add new entries to the list or edit existing ones. 
 
Edit/Delete Tab is used to edit the names of Standards and Trials or to delete them.  The pane 
on the left side shows a listing of the names of the Standards while the pane on the right shows a 
listing of the Trials associated with the selected Standard.  If any Batches are associated with a 
Standard, then the Batch names are also shown in a tree structure.  Batches are only applicable 
to the Match Silver and Match Gold licenses. 
 
Formulas Tab is used to display the name(s) of the product line(s) for any formulas associated 
with the selected Standard.  You can also delete a formula for a specific product line from the 
database by clicking on the Delete button.  .  If the “Use Filter” option is checked, then only those 
Standards that meet the filter criteria are displayed.  If the “Verify Deletes” option is checked, then 
for each delete, the user will be asked to confirm that he wants to delete this record. 
 
 
Database Menu - The options under this menu are 
shown here.   
 

• Database Options will open the Transfer Tab 
on the Database. 

 
• Change Database will open the dialog to select 

a different database. 
 

• Save Current Document To Database will save 
the Standard and any Trials to the Database 
either as a new record or it will replace a 
current Standard if a sample with the same 
name is found.  Any changes to any trials will also be saved.  This includes edits, 
deletions, or additions of any trials. 

 
• Import Save Set to Database will open a dialog box where you select whether to Store All 

Trials as Standards; whether to Overwrite Existing Data; and whether to Prompt Before 
Overwriting.    After clicking OK, then the user selects the save set to copy to the 

database.  You 
can browse to a 
different folder or 
network drive to 
locate the files to 
be imported.  
CyberChrome 
formats of WSV, 
SVS or WSL are 
supported.  To 
import data 

under other formats, use the File-->Open command to open another one of the supported 
file types.  This includes importing the data from a spreadsheet-type or TXT file.  Follow 
the Help on this procedure and then save the data into a WSV file, which can then be 
imported to the Database here. 

 
• Edit/Delete Standard will take you to the Edit/Delete tab in the Database of Standards.  

Follow the instructions given above. 
 

• Edit/Delete Trials will take you to the Edit/Delete tab in the Database of Standards.  
Follow the instructions given above. 

 
• Upgrade Database upgrades a V5 OnColor database to a V6 Database.  OnColor V6 can 

read and save to V5 Databases, but V5 cannot read a V6 Database.   Without upgrading 
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the Database you cannot take advantage of the new features in V6.  Before upgrading a 
V5 Database, we strongly recommend that you make a back-up copy of the Database 
(meaning the .MDB or .SQL file) before proceeding.  Also note that once a V6 Database 
is upgraded you cannot un-do this operation and anyone using OnColor V5 will not be 
able to use this upgraded Database. 

 
• Compact Repair Access Database runs a utility that compacts the database from any 

deletions that have been made and fixes some database errors.  If you are getting any 
Database errors, run this utility first to see if they can be rectified with this simple 
procedure. 

 
To Open a Database of Standards:  (without using Data Sources (ODBC)) 
 
The first time you open a Database of Standards in a new installation of OnColor, the database 
called “Color Database” will be loaded.  You can work in this file or open a different one.  Click on 
Database-->Database Options or type the shortcut key “D”.  The Database window will open on 
the Transfer tab.   Make sure the Use Data Sources box is unchecked. 

1. Click on the <Open> button.  A dialog box for Database File to Open is displayed for you 
to browse and find the Database that you want to open.  The default directory is the one 
that was selected during installation of OnColor.  Go to View-->Default Directories if you 
need to revisit what that is.  Databases may be stored on any drive that your computer 
has access to. 

2. Highlight the file (.MDB) that you want to open, and then press the <Open> button. After 
the database has been loaded, you will see the file you opened listed under Current 
Database.  When you click on <OK>, the database will close.  You are ready to store 
reflectance data or the match formulas in the current *.mdb file.   

3. The name of the current Database of Standards in shown in the Status Bar in the lower 
right portion of the screen (next to the name of the current Property file). 

 
Hints and Reminders: 

1. You can also use the menu command Database-->Change Database to select a 
database. 

 
To Open a Database of Standards:  (using Data Sources (ODBC)) 
 
The first time you open a Database of Standards in a new installation of OnColor, the database 
called “Color Database” will be loaded.  You can work in this file or open a different one.  Click on 
Database-->Database Options or type the shortcut key “D”.  The Database window will open on 
the Transfer tab.   If you want to use Data Sources to find your database, make sure the box is 
checked to do so. 

1. Select the <Open> button.  This puts you in the Select Data Source window.  Stay in the 
File Data Source tab. Click one time on the desired *.dsn file.  The name will appear in 
the DSN Name box.  Select the <OK> button to load the database.  This may take a few 
seconds.   

2. After the database has been loaded, you will see the file you opened listed under Current 
Database.  When you click on <OK>, the database will close.  You are ready to store 
reflectance data or the match formulas in the current *.mdb file.   

3. The name of the current Database of Standards in shown in the Status Bar in the lower 
right portion of the screen (next to the name of the current Property file).  

 
Hints and Reminders: 

1. You can also use the menu command Database-->Change Database to select a 
database. 
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To Create a new Database of Standards:  (without using Data Sources (ODBC)) 
 

1. An empty database named “Color Database” is installed with OnColor V6 and is the 
default Database of Standards upon startup.  You can begin using this database “as is”, 
or you can rename it.   

2. OnColor is also shipped with an empty database of standards, called appropriately 
“Empty Database.MDB”.   It is installed to the default directory chosen at the time of 
installation.  Go to View-->Default Directories to see what this is.   

3. To create a new blank database use Windows Explorer to make a copy of this empty 
database and rename it according to your needs.  It is a good idea to keep this copy of 
“Empty Database.MDB” available for future needs. 

4. After you have made a copy and renamed it, then use the instructions above to open it in 
OnColor and begin using it. 

5. The first time you use this database, it will ask you what additional Tables you want to 
create.  For QC users, you can store Tolerances; for Match users, you can store 
Tolerances and/or Formulas.  Check the appropriate boxes and the tables will be created 
and ready for your use.  If you do not add these Tables now, they cannot be added on at 
a later time.   

 
To Create a new Database of Standards:  (using Data Sources (ODBC)) 

1. Select File, then Database of Standard or type the shortcut key “D”.  When selected 
it may take several seconds to load the current file.  The first screen is the Transfer 
Tab.  This lists the current database loaded, the records stored in the database, the 
current Save Set and the standard and trial(s) in the Save Set.  To use the ODBC 
drivers and Data Sources, check the box for “Use Data Sources (ODBC).”  

2. Select the <Open> button.  This puts you in the Select Data Source window.  Click 
on the New button. 

3. The next window is Create New Data Source.  The Microsoft Access driver (*.mdb) 
should be highlighted, click on <Next>.  

4. The next window is still Create New Data Source.  This is where you type in the 
name of the link (*.dsn) you want designated.  Click on <Next>. 

5. The next window tells you that you just created the filename (which is your *.dsn file).  
Click on <Finish>.   

6. The next step is to create the actual Access database (MDB file).  A dialog for the 
ODBC Microsoft Access  Setup will open.  In the Database section, click on 
<Create>.   

7. This command puts you in the New Database window.  Browse to the directory 
where you want to create this new database.  Under Database Name, type in the 
name of your database (*.mdb), and click on <OK>.  We recommend that you name 
the MDB file the same as the DSN or data source; that way you will always know 
which files go together. 

8. The next dialogue box should say the Database was successfully created. Click on 
<OK>. 

9. Click <OK> again to exit out of ODBC Microsoft Access  Setup. 
10. In Select Data Source window you will see the *.dsn file in the main box.  Click on the 

newly created *.dsn file.  The name will appear in the DSN Name box.  Select <OK> 
again. 

11. In the next window you have the option to select what additional data you want to 
store in the database.  Click on Tolerances to save the pass/fail tolerance criteria for 
each standard; click on Formula Data to save formulas (colorants and amounts) for 
each standard.  Any combination of these can be selected.  The option must be 
selected at this time and cannot be added later.  The more options selected, the 
larger the database will be.  The Formula Data option is available only on matching 
packages. Click  <OK> to continue. 

12. The database will load.  This may take a few seconds.  After the database has been 
loaded, you will see the file you created listed under Current Database.  This new 
database will contain 0 records at this point.  When you click on <OK>, the database 
window will close but the database remains the active one and is noted on the Status 
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Bar in OnColor. 
13. You can now transfer reflectance data to the database from any of the active save-

sets by clicking on the standard or trial and then clicking on the left arrows. 
14. After making color matches and you wish to store the formula into the database, 

Select Match on the menu bar, then click on Save Formula. The current formula will 
be stored in the new database (*.mdb) you just made.  Note: any formula saved will 
always be stored in the current database in Database of Standards. 

 
 
To store and recall data into the Database of Standards: 

1. Go Database-->Database Options or use the hot key “D”. 
2. On the right side of the Transfer window are listed the standard and trials in the 

current save-set (WSV file).  Use the left and right pointing arrows to copy records 
from one file to the other.  The procedure works both ways. 

3. You can also recall something from the Database using the menu commands 
Standard Recall or Trial  Recall. 

4. Similarly, you can save a sample to the Database using the menu commands 
Standard Save or Trial  Save. 

 
To Search the Database of Standards: 

1. Open a new document and measure the target color to be searched for as a 
Standard. 

2. Click on Trial  Search or type the shortcut key F6.  The program searches the 
database for the “n” closest shades that are within a certain DE as specified in the 
Search Tab of the Database of Standards.  For example, the program returns the 5 
closest shades that are less than 10 DE from the Standard.  They are reported as 
Trials in order from lowest DE to highest DE.  The criteria for the Search are set in 
the Database of Standards  Search Tab.  If “Database Filtering” is checked to 
ON, then the list of records in the database will be filtered accordingly.  In order to 
use filtering, you must either have the Alternate Name field and/or System fields 
populated.  The System field is generally set-up to indicate the product line, but it 
could also be used to enter the customer or any other criteria that is useful to search 
on. 

3. Alternately, you can go to Database -->Database Options or use the hot key “D”. 
4. Click on the Search button.  The program searches the database for the “n” closest 

matches to the Standard in the current save-set, same as indicated above. 
 
To Use Database Filtering: 

1. The Database can be “filtered” according to the Alternate Name, Customer, Palette or 
date and time.  The date and time of measurement is always tagged with each reading.  
The Alternate Name, Customer and Palette are fields that must be input at measurement 
time or else edited later. 

2. The List of Customers and Palettes are entered by going to File List Management and 
then selecting the appropriate tab.  You can Add, Edit, or Delete these filter names here.  
Same for Jog Labels and Colorant Attributes, although you can’t use job labels or 
colorant attributes to filter the database. 

3. If you have populated at least some of the records in the Database of Standards with 
Alternate Names, Customers, or Palettes, then you can turn on “filtering” on either the 
Transfer tab or the Filter tab in the Database of Standards window.  You can also turn on 
or off filtering when you do Standard Recall or Trial Recall. 

4. When “Filtering” is turned on, then only those records that meet the filter criteria will be 
listed or searched.  You can use multiple filters at a time. 

 
To Recall a Standard with a Stored Formula: 

1. If you have OnColor Match Gold or Silver, then formulas can also be stored with each 
Standard in the Database of Standards.  A formula is stored in the database by going to 
Match Save Formula after doing a match.  The current formula displayed on the 
screen is saved.  This can come from a combinatorial match, a single match, manual 
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match, or the New Formula after a batch correction.   
2. To recall a Standard with a Stored Formula, first you must be certain that the proper 

colorant file (.CLR) is the current active file.  The easy way to do this is to recall a PRP 
file that references this CLR file.  Then go to Standard Recall and choose the desired 
standard from the list.  If a formula exists for this standard and the correct colorant file is 
active, then the formula is recalled along with the Standard color data.  If the correct 
colorant file is not open on the active save-set, then the Standard color data is recalled 
without a formula. 

 
Hints and Reminders: 

1. You can use the Database Formula tab to view which standards have formulas stored 
with them.  Highlight the Standard of interest on the left pane.  In the right pane, the 
names of the Colorant Systems for which formulas are stored for that standard are 
displayed. 

2. Again, the Colorant System must be active in the current property file (PRP) in order for a 
formula to be recalled. 

Menu Options:  
The following sections give a brief overview of all of the other Menu options available in 
OnColorQC.  For a detailed description of how to use these features, go to the complete OnColor 
Manual by clicking on the Windows shortcut on your desktop to the OnColor Manual.  This 
manual was copied to your computer during installation.  The file name is: 
 OnColor Manual V6x.doc. 
  
File menu commands: 
 
New   Opens a New *.WSV save-set file or *.CLR colorant file 

Open Opens an Existing *.WSV save-set file or *.CLR colorant file 

Close  Closes the Active *.WSV save-set file 

Save    Saves the active *.WSV data file using its current name and path 
Save As Saves the active *.WSV data file to a specific file name and path 

Workspace   Provides the options to manage and create  Workspaces 

List Management  Create and edit the lists for Customers, Palettes,  and Job Labels, and 
Colorant Attributes 

Security    Set the security levels and manage the password protection in OnColor 
Spreadsheet.   Export the current data to a spreadsheet format 
Send Mail  Sends the active file, data, or screen capture using E-Mail 
Print  Prints a report of the current data 
Print Preview  Displays a preview of the selected report of the data on the screen 
Page Setup    Sets the margins and font for the printout and enter the Company Name 

and Address for print-outs 
Print Setup   Selects a printer and printer connection 

Print Label Selects a label template and prints a label on a Dymo Label printer 

Exit   Exits OnColor 

Recent Files  -1, -2, -3, -4  Opens the most recent WSV or CLR files listed 
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Database menu commands: 
 
Database Options Opens the Database dialog box with option for Transfer, Search, Filter, 

Edit/Delete, and Formula management 
Change Database Select a different database as the active database 

Save Current 
Document to 
Database 

Saves the current open document (or save-set) to the Database; saves 
the Standard, tolerances, and all Trials 

Import Save Set to 
Database 

Select a stored WSV file to import the Standard and Trials to the 
database; the file must be saved first before importing it; supports WSV, 
SVS, and WSL formats 

Edit/Delete 
Standard 

Used to edit or delete standards and associated records from the 
database of standards 

Edit/Delete Trial Used to edit or delete trials  from the database of standards 

Upgrade Database Converts an OnColor V5 Database of Standards to V6 format 

Compact/Repair 
Access Database 

Runs a utility program to compact and repair connections in a V6 format 
Access database (not SQL format) 

 
 
Standard Menu commands: 
 
Measure    Measures a sample and designates it as a Standard; takes a single 

scan. 
Average    Averages a number of scans to comprise one standard measurement. 
Keyboard    Input of standard values via the keyboard. 
Edit    Edits the standard name, % reflectance and colorimetric data. 
Null   Enters a null standard 
Save   Saves the current Standard to the current Database of Standards 
Recall    Recalls a Standard from the current database. 
Most Popular  Polls all trials to determine which standard they are closest to in a multi-

standards file 
Utilities   Options to copy, delete, find, select/deselect, and sort the standard data 
Download    Downloads the current standard from OnColor to the portable 

instrument 
Upload    Uploads target and/or trials from the portable instrument to OnColor 
Switch    Switches the current Trial  into the Standard position and vice versa. 
Average Trials Average all trials to create a new standard. 
Auto Naming  Toggles auto naming of the trials on/off 
Position    Enable/disable use of sample previewing mirror with CM-3500 before 

measurement. 
Naming Options  Naming options for standard name. 
Multi Standards  Mode allows for multiple standards to be managed in a save-set (WSL 

file); acts as a toggle to turn this feature on/off 
Multiple Standards  Selects the standard to be used for display purposes 
Hitch Mode Turns the Hitch Mode on/off 
Hitch Management Manage the options to “hitch” an instrument to a specified data point 
Naming Options Controls the formation of the name of the Standard and Trials and 

display; also allows you to enter default names 
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Trial menu commands: 
 
Measure    Measure a sample and designates it as a Trial to be compared with 

the current Standard; takes a single scan. 
Average    Average a number of scans to comprise one trial measurement. 
Keyboard   Input of trial values via the keyboard. 
Edit    Edit the trial name, % reflectance and colorimetric data. 
Measure from File Reads the names of the Trials from a file (used when measuring the 

Profiler Tiles or a large fandeck) 
Measure Loop Used with portable instruments to initiate a measuring loop when 

measuring numerous trials 
Save Saves the current Trial to the Database of Standards 
Recall    Recalls a trial from the current database 
Search.   Search for closest match to standard from database of standards. 
Utilities   Options to copy, delete, find, select/deselect, and sort the trial data 
Average Last n Trials Creates a new Trial from an average of the last “n” trials 
Auto Naming    Toggles auto naming of the trials on/off  
Insert Mode   Inserts the next trial in this position. 
Position    Enable/disable the use of the sample previewing mirror with the CM-

3500 before measurement. 
Auto-Select Standard    Search for closest standard within all opened save sets. 
Auto-Save    Toggle this feature on/off to automatically save a measured trial to 

an existing file. 
SCI/SCE Must Agree Displays a warning message if the specular component for the Trial 

is different than the Standard 
Naming Options    Controls the formation of the name of the Standard and Trials and 

display; also allows you to enter default names 
 
Report menu commands: 
 
User Defined  Displays the 4 quadrant user defined screen.  Choose from any 

combination of the following report screens. 
Color Plot    Displays the color plot screen with colorimetric absolute values and color 

difference data for 1 to 3 Ill,  Includes a cross-hair color plot in 2D or 3D 
in absolute or delta mode 

Data Table   Displays the data table screen for all Trials in the current document; can 
copy all the data to the Windows clipboard in  single click 

Spectral Plot   Displays the spectral plot screen with a tabulation of the %R or %T data 
or K/S or Absorbance 

Tolerance Plots   Displays the tolerance plot screen and manages the current tolerances 
and selects the method of Pass/Fail assessment 

Statistical Charts   Displays the statistical charts screen in either trend chart in bars, lines, 
or histograms along with the Mean, Std. Dev., and Variance for the 
current set of Trials 

Print QC Label Prints a QC label to a Dymo printer from a chosen template 
Properties    Change the properties (screen layout) and default parameters for the 

active report. 
Save Properties As   Save all report properties (screen layouts) and current options for later 

recall. 
Recall Properties   Recalls a PRP or property files and sets all report properties (screen 

layouts) according to this template 
Recent Files  -1, -2, -3, -4, -5  Opens the most recent PRP files listed 
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Options menu commands: 
 
Macro   Macros are used to program a series of OnColor operations into one 

repetitive function 
Averaging   Pre-select a fixed number of measurements to average or set the 

minimum   and maximum number to average, or set a fixed time 
between measurements. 

Tolerances   Select to view or edit box tolerance, elliptical tolerance, or for 
PASS/FAIL assessment. 

555 Block Sizes   Select to do 555 shade sorting and set the block sizes 
Observer / Illuminants   Select illuminants and observer. 
Color Space   Select the color space shown on output. 
Indices   Select which indices are displayed from a list of over 100 choices 
Adjusted Strength Select which method of % Strength calculation is used and other 

parameters for strength calculation 
Opacity / Reflectivity   Performs opacity/reflectivity measurement measuring a sample over 

a white and black background to get % Opacity (contrast ratio) and 
reflectivity 

Haze / diffuse 
Transmittance   

Performs haze calibration and haze measurement. 

Measure Background    Changes the white and black background when using Haze or 
Opacity options. 

Gloss Correction   Applies a gloss correction to each measurement that is taken   
Calibration    Calibrates the instrument  
Instrument Settings   Selects the SCI/SCE; aperture and mask; UV energy settings, etc. 
Calibration Interval   Select to enter in the time interval for instrument calibration. 
Remote Measurement   Waits for the Measure Button to be triggered on a portable 

instrument rather than via the PC 
Communications   Change or test instrument communication 
Profile Settings Activates instrument profiling and displays the settings and CCF file 
Instrument 
Performance 

Checks the performance of your instrument using a set of ceramic 
tiles and manages the Instrument Performance database 

 
 
 
View Menu options: 
 
Toolbar   Show or hide the toolbar.  Choose from a menu of various 

toolbars to activate for display 
Status Bar   Show or hide the status bar in the lower right section of the 

screen. 
Application Look Choose which Office display style is used for the overall OnColor 

application 
Keyboard Shortcuts   Create shortcut keys that accesses menu commands in a single 

keystroke 
Default Directories      Displays the default directory for the file type selected.  Can be 

changed to direct OnColor to save and look for files in another 
path and folder. 

Logo File Directs OnColor where to look for the  location and name of the 
logo file used on the print-outs 

Visual Style Toolbar Gives a choice of the visual styles available for the displays 
Select Font   Select the display font. 
Select Colors   Select display colors. 
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Calibrate Color Patches   Select to calibrate the color patches on screen. 
Previous Standard   Scroll to display values for previous Standard in a multi-

standards file 
Next Standard   Scroll to display the data for the Next Standard in a multi-

standards file 
Previous Trial   Scroll to display values for previous trial. 
Next Trial   Scroll forward to display values for next trial. 
Previous Meas. Status   Displays the data for the previous status on a multi-status file 
Next Meas. Status   Displays the data for the next status on a multi-status file 
Measurement Status 
Sequence   

Selects which measurement statuses are displayed in a       
multi-status file 

Display Notes  Displays the notes associated with the Standard and Trials. 
Rotation Default Applies the Rotation Defaults that you have saved for the three 

axes. 
Save Rotation Defaults Saves the current settings for the Rotation Defaults for all three 

axes.  Set them to your favorite view and then save them as the 
default. 

Zoom   Uses the zoom feature to zoom in, zoom out, or return to the 
default position on graphs 

 
  
Window menu commands: 
 
New Window   Creates a new window that views the same document.  Use this command 

to display more than one report screen at a time. 
Cascade   Arranges the open documents in an overlapped fashion. 
Tile   Arranges the open documents in non-overlapped tiles. 
Arrange Icons   Arranges icons of closed windows. 
Window 1, 2,   Selects the window to become active in the foreground. 
 
Help menu commands: 
 
Index    Offers you an index to topics on which you can get help. 
Contents   Provides a Table of Contents and easy acces to Help 
Search    Allows you to search for a topic in the online Help 
About    Displays the version number of this application. 
CyberChrome 
On the Web 

Provides a link to the CyberChrome web site for sales, support, and other 
services options 
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OnColor Match – Quick Start Instructions 
 

A complete OnColor User’s manual is included on your installation CD.  It was 
copied to your hard drive during installation of the software.  Look for the MS 
Word document called “OnColor Manual v6x.doc”.   

The following section is a supplement to the OnColor QC Quick Start Guide and 
covers the additional features of Color-Matching and Batch Correction.  Please 
read the QC Guide before beginning here. 
 
 

OnColor Match Overview 
When launching OnColor Match Gold, you will see three additional icons on your toolbar for the 
formulation options; for Match Silver you will see two.  The Menu bar and Tool bar will look similar 
to this: 
 

 
 
 
The additional icons are for the following Report Screens: 
 
 

1. Colorant Characterization Report (Match Gold only) – This feature is used 
to load or build your colorant file that contains the calibration data on your 
colorants.   You can also edit the file, add colorants to the file, edit information 

on the colorants, such as cost, strength, density, etc or add additional colorants to the 
file.  The file can either be stored in the Database of Standards or stored as a CLR file on 
a computer drive.  The Match Silver level does not contain this feature.  A Silver user 
must get a CLR file or have access to one that was created by a Gold user level. 

 
 
 

2. Match Report – This report is used to display the results of a match prediction 
or a recall of a stored formula.  The properties for this report store the 
numerous parameters used for the match and the display of the results.  Many 
options are available depending on the application.  Consult the online Help for 

a detailed explanation of these options. 
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3. Batch Correction Report – This report is used to display the results of a batch 
correction telling the operator what to add to a batch in process to bring it on-

color.  The properties for this report store the numerous parameters used in the process.  
As with matching, many options are available, depending on the application.  Consult the 
online Help for a detailed explanation of these options. 

 
 

Additional Menu Options with Match Levels 
 
Additional Options under the Database Menu 
 
Open Colorant 
System 
 

Opens a colorant system in the Colorant Analysis Report window; 
allows you to manage or append to the file; this is the equivalent of 
opening a .CLR file from V5 

Edit/Delete 
Colorant System 

Used to edit or delete a colorant system from the database of standards 
or to edit and manage a colorant system 

 
 
Match Menu 
 
Automatic Takes you to the Automatic Tab of the Match Properties where you 

can select colorants, the number of colorants/match, batch size, 
loading and other parameters and then “RUN” the match prediction 

Manual Takes you to the Manual Tab where you can select colorants and 
enter amounts to synthesize a color match or modify the amounts in 
an existing match 

Select Takes you to the Select Tab where you select the Colorant System 
or CLR file to be used and select the colorants and base for the 
match 

Numeric Takes you to the Numeric Tab where you can choose the numeric 
parameters such as math model, batch in weight or volume, batch 
size, colorant loading, and other parameters 

OPL Takes you to the OPL Tab where you enter the parameters for the 
Optimized Pigment Loading to be used in match prediction and 
enable the option 

Formula Entry Takes you to the Formula Entry Tab where you can enter a color 
formula to be stored in the Database of Standards 

Properties Takes you to the Match Properties where you can select any of the 
following tabs:  Automatic, Manual, Select, Numeric, OPL, or 
Formula Entry.  A brief description of each is given above. 

Run Match After setting the parameters for the Match, this command initiates 
the match prediction. 

Independent Run Sets up the parameters for a queue of color matches; for example, 
to match a color card or fandeck automatically with a given colorant 
system 

Sort by Cost Sorts the results of a combinatorial match by cost 
Sort by DE Sorts the results of a combinatorial match by weighted DE 
Go to Best Match Displays the Best Match from a combinatorial match 
Save All to Database Saves all of the matches and formulas to the Database as trials 

associated with the Standard 
Save Formula Saves the current formula with the Standard to the Database 
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Recall Formula Recalls the stored formula associated with this Standard from the 
Database 

Dispense Sends the output of the formula to a dispenser interface 
 
Correct Menu 
 
Input Batch Amounts Selects the colorants and inputs the amounts in the batch for a 

correction 
Use Predicted Batch 
Amounts 

Uses the colorants and amounts predicted from a match to the 
Standard as the input for what’s in the batch; use this only when you 
have made up  this first shot match 

Unknown Batch 
Amounts 

Use this option when you do not accurately know either the colorants 
or the exact amounts in the batch 

Waste Workoff Use this option to correct a batch of unknown composition to a 
different shade 

Input Add Amounts Use this option to enter the Add Amounts that you know you want to 
use to correct the batch 

Input Offset for 
Correction 

Corrects a batch to an offset from the standard; use this option to 
input the offset in terms of DL, Da, and Db 

Base Strength 
Correction 

Calculates the tinting strength of a white base and computes how 
much of an add of either clear or white is needed to bring it on 
standard 

Manual Add Allows the operator to manipulate the add and make changes to the 
OnColor automatic correction 

Reduce Add Minimizes the amount of the add by allowing a DE larger than 0.0 
Change Correction 
Factors 

Allows the operator to change the correction factors used in the 
computation of the Add 

Properties Brings up the Batch Correction properties dialog to enter the 
parameters for the correction;  choose from the Automatic, Manual, 
Select, Numeric, Base Strength, or Offset tabs to change the 
parameters 

Run Batch Correction Performs the batch correction of the current trial to match the 
standard 

Save Formula as 
Batch after Add 

Saves the current formula with the add and the current batch size to 
the standard in the Database of Standards 

Save All to Database Saves all of the trials in the current document and their current 
formulas and associates them with the current Standard in the 
Database of Standards 

 
 
Report Menu – additional options with matching and correction 
 
Print Formula 
Label 

Prints a Formula Label of a match prediction to a Dymo printer from a 
chosen template 

Print Correction 
Label 

Prints a Correction Label of a batch add to a Dymo printer from a chosen 
template 
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Color-Matching 
1. Before doing a computer color-match you must have a colorant system stored in the 

Database or have a colorant file (CLR) loaded.  The colorant system or CLR file contains 
the data on your colorants, pigments, or dyes as characterized in your product. If you do 
not have a colorant file, then you must either load one or obtain one from a master 
source (such as your supplier, your R&D or technical department, etc.) 

2. After you have your colorant file loaded and/or stored on your computer, you should set 
up a Report Property file (.PRP) that calls up this colorant file and selects the other 
matching parameters.  Go to the Match Report   or configure the User screen to have the 
Match Report in one of the quadrants.  Several matching .PRP files are included with 
OnColor.  Pick the one closest to your application (such as COATINGS.PRP, 
PLASTICS.PRP, TEXTILES.PRP, etc) and use it as a template to customize it for your 
colorant file and your application parameters. 

3. To configure the Matching parameters, double-click in the Match Report to bring up the 
Formulation Properties dialog box.  The Style tab controls the type of information 
displayed on the screen.  The Select tab allows you to pre-select a colorant file (CLR) 
and the colorants you want to use for matching; and the Numeric tab allows you to enter 
the Batch Size, units of weight or volume, math type, number of colorants in the match, 
and the DE limits for the matches.  Enter your desired application parameters to 
customize it for your needs. 

4. After selecting all of these matching parameters, save these settings as a Report 
Property file (PRP).  To do this, click on Report Save Properties As, and then select a 
path and filename.  If you save this as your STARTUP.PRP file, then these will be the 
default settings whenever you launch the program. 

 

3 Easy Steps to Do a Color Match 
 

1. Type “P” to recall the Report Property file that contains the matching parameters that you 
want to use if it is not already active. 

2. Type “S” to measure the color to be matched into the Standard position or recall it from a 
file. 

3. Type “M” to do a combinatorial match. 
 

 
 
 
 
All possible matches that 
meet the match criteria are 
sorted by a weighted DE and 
displayed.  The Best Match is 
shown as Trial #1.  The 
second best match is shown 
as Trial #2, etc.  Use the  
and  arrow keys to scroll 
through the possible 
matches. 
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TIP:  Right click in the Match quadrant to display a shortcut menu where you can:  Sort the 
matches by cost; Sort them by DE; Save the Formula to the Database of Standards; or change 
the Match Report Properties. 
 
Select the match that best meets your criteria of metamerism, cost, and colorant selection.  Save 
the formula to the Database of Standards (Match  Save Formula or right click in the Match 
quadrant) for easy recall at a later time in case you need to do a color correction to this match.  A 
typical user screen showing the results of a match prediction is shown above. 
 
 
 

Batch Correction   
 

OnColor contains powerful color correction routines that help you correct the color of a laboratory 
hit or production batch.  Just as with the Matching options, we recommend that you set up a 
Report Property file specifically for doing batch correction.  This PRP file would pre-select the 
colorant system or file, batch type, and numerical match parameters for the correction, allowing 
you to recall all of these setting with a single mouse click.  Go to the Batch Correction Report or 
configure the User screen to have the Batch Correction Report in one of the quadrants.  Samples 
of some Correction PRP files can be found in the Demo Files folder.  You can start with one of 
these based on your application and then modify it with your colorant file and parameters. 

 
 

4 Quick Steps to Do a Batch Correction 
1. Recall the Batch Correction Report Property file (PRP) that you created. 

2. Recall the Standard from the Database of Standards (Standard  Recall, then select it 
from the list).  This will also recall the colorants and the formula if you stored it.  If you did 
not store the standard, measure it now by typing “S”. 

3. Measure the batch to be corrected as a Trial by typing “T” on the keyboard.                              

4. If you recalled the formula along with the Standard from the database, then type “B” to 
perform the batch correction.  If you did not store the first hit in the database, then go to 
Correct Input Batch Amounts and select the colorants in the batch and enter the 
amounts for each colorant.  Then click on <<Run>. 

The “Add” to be made to 
the batch is shown in the 
Batch Correction Report 
along with the starting 
formula and the final 
formula after the add is 
made.  Depending on the 
parameters chosen, 
correction factors and the 
% change to each colorant 
are displayed.  Changes to 
the output to this screen 
are made on the Style tab 
of the Batch Correction 
Report dialog box.  You 
can easily change these 
properties by double-
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clicking in the Batch Correction quadrant and going to the Style tab and then select the output 
that you want to see.  Don’t forget to save this Report Property file, if you want to make these 
changes permanent. 

The “New Formula” (the way to make the corrected color from scratch or reformulation of this 
color) is displayed in the Match Report.   A typical User Screen showing the Batch Correction 
Report and the New Formula is shown above. 

 

Other Batch Correction Options 
 

 
 
 
 
 
TIP:  Right click in the Batch Correction quadrant to get 
this short-cut menu of options for manipulating the add 
and calculating alternative corrections.  The Optimize 
Add feature from V5 of OnColor is now combined with 
the Manual Add feature for streamlined operation. 
 
 
 
 

 
 
 
Under the Batch Correction Menu you will find additional post-processing options to: 

1. Save the Formula as Batch After Add – This will store the Standard color along with the 
current batch formula after the add to the Database of Standards.  If you need to do 
another correction, recalling this information will load the correct colorants and current 
amounts in the batch into the correction routine. 

2. Save All to Database – This option saves the Standard, all the Trials and their formulas 
with the adds to the Database.  The Trials and formulas are associated with this standard 
in the Database. 

3. Create New Batch – This option creates a new Batch associated with this Standard.  A 
Batch contains all of the “hits” or formulas used to make one batch of this color.  One 
Standard can have many Batches, and one Batch can have many hits or Trials.  Batches 
are used to track the adds or hits made to a particular batch through the color-matching 
process. 

4. Manual Add – allows the operator to zero out the automatic computer adds and then 
enter his idea on the amounts to be added to correct the batch.  The color difference data 
is displayed for the new proposed correction.  The <Optimize> button located on the right 
side of each colorant amount can be used to “optimize” the amount of this colorant in the 
add.  Any combination of Manual Add and Optimize Add can be attempted.   One or more 
colorants can be added at the same time.   

a. If you want to do a Manual Add, click on Correct  Manual Add or use the right 
click in the correction quadrant to access the shortcut menu. 

b. Use the Zero Add button to set all of the add amounts to 0.0. 
c. Enter the amounts that you want to use and click on APPLY to see the change in 

the DE.  Click OK when you are satisfied with your add. 
d. Optimize Add – provides an option to see if the batch can be corrected to an 

acceptable DE by adding the “optimal” amount of one colorant.  To Optimize the 
add for any colorant, click on the <Optimize> button for the appropriate colorant.  
You can optimize more than one colorant in succession. 

5. Reduce Add – asks the correction routine to find a minimum add to get to an offset DE.  
The operator selects a DE greater than zero and the software will attempt to add the 
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minimum amount of colorant to get to this DE.  The automatic correction routine always 
attempts to adjust the batch to zero DE. 

6. Change Correction Factors – allows the operator to change the correction factors that are 
applied to the add.  This alternate correction factors can come from known strength 
information or from other successful adds.   

7. Print Correction Label sends the correction output to the Dymo LabelWriter.  You must 
have a template setup prior to using this option.  Read more on How To Print Labels in 
the OnColor Help.   

8. How to Add a Colorant to the Batch for Manual Add:  Follow these steps to add a fourth 
colorant to the batch for the purpose of making a manual add.   
1. Do a Batch Correction with 3 colorants 
2. Get your answer displayed on the screen, then right click in the Correct quadrant to 

bring up the Manual tab. 
3. Change the # of colorants to 4 and click Apply. 
4. Select the 4th colorant using the drop down list.  This will be in the next to last slot.  

Remember that the White must be in the last slot. 
5. Your add amounts in the boxes should equal the add amounts that are on the 

screen. 
6. If you want to zero out the existing add, do it now. 
7. Then, enter the desired add amount of the 4th colorant and hit Apply to see the effect 

on the DE. 
 

Loading a Colorant Database 
 
Detailed steps for characterizing a colorant database are given according to application type in 
the full OnColor manual.  Recommendations for the proper samples to prepare can also be found 
here.  The scope of this topic is too lengthy for this Quick Start Guide.  Please consult the full 
manual for these instructions or contact your OnColor applications expert to help you.             
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